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Preface

Users installing and operating the product is required to understand this manual and relative manuals

fully before installation and operation.

All rights of the software and hardware described in the manual are protected by the patent law.

Not This icon means “Note” explaining the procedure and additional information.
ote

This icon means “Caution” explaining important information or limitations of

cauion  Caution the operation. .
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1. Overview
1.1 Introduction
This program is Central Management System that is designed to control various security
devices(IP camera, DVR, NVR, Video Sever) connected from a single PC by networking. This
program consists of the multi-functions including the live image monitoring, real-time event
management, security device status monitoring, and then image search, playback, download,

smart search and watermark etc.

1.2 Feature
In the program, users can register security devices without quantity limitation and it provides a
real-time monitoring of max. 128 cameras as long as VGA card in PC supports two monitors.

Users can control a function window size as each function has a separate window.

This program manages the user account and group. It provides a separate management of the
user account by allowing the administrator to set the authority of detail features for the group.

This program manages and saves events that were sent from many security devices. This
program reports users an alarm set with events through the pop-up message, audio and real-time

image etc.

In the network player, users can search the recorded file and play and download the image and
audio. A searching term by second is available and the preview screen enables users to search

images without playing actual images.

The recorded file with images and audios in PC can be played by File Player and it provides a

faster search of information by the smart search and water mark.

2. Installation
2.1 System Requirement
In order for proper operation of the program, it requires PC more than the min. specification. With

the min. specification, it only provides min. functions. For full operation of the program, PC is



required to be equipped with more than the recommended specification.

System Min. Specification Recommend Specification
CPU Intel Core2Duo 2.0GHz Intel Core2Quad 2.66GHz
Main Memory 2GB 4GB or higher
Video Card Memory 128MB 512MB or higher
Display Resolution 1024 * 768 (With 32bit color) or higher

HDD 80GB or higher

oS Windows XP SP2 or higher

Others Direct X 9.0 or higher

2.2 Installation Guide
1. Insert software CD into the CD drive of PC.

2. Click on Setup.exe. An install program will be executed and a language selection page will
shows up.

Choose Setup Language @

ﬁ Select the language for this installation franm

the choices below.

3. Select a desired language.

4. Designate a folder in which the program is installed and click on “Next”, and then installation
starts.
x|

Choose Destination Location

\. 1

Select folder where Setup will install files.

Setup will install Metus Standard in the fallawing falder

Ta install to this folder, click Next. To install to a different folder, click Browse and select
another folder.

Destination Folder
’7E'\Plngram FileshMetuz Standard Browse... |

InstallEhield

Cancel |




3. System Login

System Login is to decide a program execution/block by confirming the user name and password.

3.1 Site Registration

1. In the program start menu, go to Netus Standard Menu and select Netus Standard icon or

double-click on Netus Standard icon in the wallpaper, and then the login window pops up.

2. Select one of the names of registered users in the login window. For the first time login,

select Administrator. Administrator is registered as a fundamental user.

P User Login

x|

User Mame : I.ﬁ.dministrator

=

&

Password : '

[ o 1|

Cancel

3. Enter a password. For the first time login, enter an administrator password.

administrator password “1111111”. After login, change the administrator password.

PP User Login

x|

User Mame |.°.u:|rninistratnr

=

&

Password : |'“““|

[ o 1]

Cancel

4. The program starts if the password is right.

v

Note

m To change the password, go to ‘Setup’->‘Password Change’ menu. (For

more information, refer to ‘5.2.9 Password Change’.

m In Netus Standard program, multi-user registration is available, all users can

log in one PC with separate user information. Each user can configure a

preferred program environment, and then the program starts according to

each user’s setting after login.

m Information of the latest window environment will be saved when the

program is closed.

4. Initial Instruction
4.1 Site Registration

The

Security devices need to be registered after login. With registered security devices, users can use

functions including real-time monitoring, search and playback, backup and event alarm.
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4.1.1 Registration

1. Select ‘Setup’->'Site Manager’ menu. Site Manager Setup window shows up.

2. In Site Manager, functions including site add, delete, modify, all select, all clear and

properties are available.

x

Sike Marne

| Address | Descripkion

| Camera | Add

15 Sequl Bldg 11F
154 Busan Bldg 2F

192.168.100.53 R&D Center
192.165.100.54 Front

16 -
Modif

16 ¥
Delete

Al Select
Al Clear
Properties

Close

3. Click on ‘Add’ and enter a security device name, description, connect address and port.

P Add Site x|

@ Alias Mame ! |

Description |

Sike Address

Connect Address |

Part

Zamera Counk

User Name : |
Password : |
Confirm : |
TR Cancel |
4. In ‘Modify’ users can modify the

security device name, connect address

and port.

Item Description
Name Name of the security device to be
used in the program

Description | Description of the security device

Connect Network address of the security

Address device

Port Network port no. of the security
device

Camera The number of cameras

Count connected to the security device

User Name User name registered in the
security device

Password Password registered in the
security device

5. In ‘Delete’, users can delete selected sites.




® Site Manager x|
Site Mame | Address Description | Camera | Add
15 Sequl Blidg 11F 192, 168.100,53 RED Center 16 Wodfy
—E Busan Eldg 2F 192.163,100.54 Frant 16
Delete
x
\‘5) Delete Address ltem?
x|
All Select
All Clear
Properties
Close

6. Clicking on ‘All Select’ makes all sites selected and ‘All Clear’ makes all sites un-ticked.

P Site Manager x|
Site Mame | Address | Description | Camera | Add
—E Seoul Bidg 11F 192,168.100,53 RED Center 16 Modify

—.& Busan Bldg 2F 192,168,100.54 Front 16

Delete

All Clear
Properties

Close

':EI Note = Netus Standard program automatically starts a connection to ticked
addresses in Site Manager after successful login.
m A connection doesn’t happen for un-ticked security devices.

m There is no limit for registering sites in Netus Standard program.

4.2 Screen Layout Registration
Screen Layout enables users to collect and monitor desired real-time monitoring images from

various security devices. Users can register desired cameras in a desired channel mode.

4.2.1 Registration
1. Select ‘Setup’->’Screen Layout Manager’ menu. Screen Layout Manager window shows up.

10



P Screen Layout Manager

Layout Name | Description | Channel Mode |

IMadify |
Delete |

Al Select |
All Clear |
Propettiss |

Close |

2. Click on ‘Add’. In Screen Layout Setting window, select Channel Mode and drag cameras
from the list at left and drop them onto desired locations, and then the real-monitoring image

turns up. Screen Layout Name and Channel Mode must be filled for registration.

P® Screen Layout Setting x|

Screen Layout Name |

Description : ‘

Channel Mode : (4 6 8 {9 10 (i @ 16 {15! 36 49 64

(s Seoul Bldg 11F
(@@ 1111
g 22222
i@ 33333
ga e
i{@a 5555
@a Six
Lgp Seven
@@ Eight
L@@ Mine
@p CH10
@e CH11
igg 121212
@@ 131313
@8 CH14
@9 CH1S

(g CHo1
L cHoz
L cHO3
L CHO4
L cHos

Cancel

3. After finishing camera addition, users can check a newly registered screen layout in Screen

Layout Manager. Users can modify and delete the screen layout as desired.

11



P Screen Layout Manager

Layouk Mame | Descripkion | Channel Maode |
I5'}.-EH|:1|;1 Camera Lisk korea Camera Group 16

Ix

e T

Madify

Delete

i

all Select

All Clear

Properties

dli

Close

4. Users can move a list tab in Connect List to Layout and check a list of registered Screen

Layout. Real-time monitoring images show up by using drag/drop onto the screen.

Conneck Lisk

Layout Mame: Bldg Camera List
Description: Korea Camera...
CH Mode: 16

& Site ’E Layout I

12



4.3 User Registration
User Registration is to register and manage ID of the program users. It decides the program to be
executed or blocked by confirming ID and password and also gives different authority to each

user group for all functions in the program.

Administrator as a fundamental user is registered in the administrator group. The administrator
group has authority for all functions in the program. For the first time login, use initial administrator
ID.

Eﬂl Note = The number of users to be registered is unlimited.

4.3.1 User Group Registration

1. Select ‘System’->’User Manager’ menu. User & Group Manager setup window shows up.

2. Select User Group tab.

P User & Group Manager x|
User  User Group |
Group Mame | Description
(5% Administrator User Group Admiistrator
Add Edit Remaye Propetties
Close

3. Click on ‘Add’ at the bottom of the group list.

4. Enter a group name and tick on desired functions from the group permission list.

13



¥ Add User Group x|

Group Marme : I

Description : I

[~ @roup Permissions

D Remote Live Monitoring

O remote File Search

O remote File Playback

O remote File Download

[ File Playback

D Remate DVR. Setup

O P77 Camera Control

O 1wo way Audio Contral

O relay Contral

O ovr Product Information
D Remate Live Picture Setting
O Metwork User Account

O Log File Viewer

O application Setting

O ovr Address Boak

O Picture Snapshot

D Picture Prink

D User & User Group Manager —_—

O ricture Color Adjust
[ I =l

| v

Cancel I

5. Click on ‘Ok’ and selected functions are granted to the user group. The user group name will

be shown at the user group list.

':EI N m In order to register a user group, users must log in with one of ID from the
ote

administrator group. For the first time login, use the initial registered

administrator.

4.3.2 User Registration

1. Select ‘System’->'User Manager’ menu. User & Group Manager setup window shows up.

2. Select User tab.
]

User |User Group |

User Mame: | Group Name | Description
<) Admiristrator Admiristrator User Group Admiristr ator

Add Edit Remaie: I Properties
Close

3. Click on ‘Add’ at the bottom of the group list.

14



4. Enter a user name and password and select a group from User Group. The user name and

password are the basic requirement.
X

i~ User Information

User Mame : I

Password : I

Confirm ¢ I

Drescription I

User Group : I-ﬂdministrator User Graup j

FTP: |

E-Mail : |

F— i e

5. Click on ‘Ok’ and the user name will be shown at the user list.

':EI Note = In order to register a user, users must login with one of ID from the

administrator group. For the first time login, use initial administrator ID.

15



5. Menu
5.1 View

View menu is a collection of the panel window to be used in the program.

No. Menu Function

Note

=

(1] Site Connection List Site Connection List Panel View

@] Event List

)

Event List Panel View

3] Site Status List

w

Site Status List Panel View

Basic Control

@

N

) Basic Control Panel View
Function

@)

G] Pop up Image List Pop up Image List Panel View

M| (=) o) 8

®] The Second Screen

)

The Second Screen Panel View

5

EN)

@ Network Player Network Player Execution

@] File Player

o0

File Player Execution

Device Setup
©

Device Setup Manager Execution
Manager

IE) Be el

0] Program Information Program Information View

¥ Netus Standard
System(S) View(\) Edit(E) Help(H)

=loix|

(5] Connect List ‘E Status List I ) Event List “@ Popup Imags‘- Control

®) @ ® @) an
| (@ second sereen H Remole Player (@) Local Plaer /&9 Remote Setup () Information ‘

5] Claelcli i F

anouzN e 352 x 240 [20100909 160842

@ (o Seoul Bdg 11F
Aigg 1
\ G 2222
G 33333
G 4444
(@ 5555
@@ Six
@ Seven
@@ Eight
(@ Nine
@8 CH10
o CH1L
@ 121212
g 131313 L

@9 CH14 0102109 181 . 12 amnnn
@ CH1S k =

42 ABCDEF
L cHoz

@@ cHoz [~ It 09 :CH 0 | = 11:cH 11,(Gaepo Bidg)
L) cHo4 21201002

SiteName:  Busan Bldg 2F
1P Address:  192.168.100.54
Port: 2000

UserName:  userl
Description:  Front

) sto [ tores ]

Fopup Image

2010/02/09 15:45:58

2010/02/09 15:46:09

by

2010/02/09 15:46:14

Channel: 14

Time:  15:32:25

2010002109 15V

Event:  Motion Event
Site: Busan Bldg 2F
Date:  2010/02/09

I~

|

Event ['ste I CH | stte Time. [P Time I
REC Off Gaepo Bldg 2010/02/09 18:07:58  2010/02/09 18:22:20
REC Off Gaepo Bldg 13 2010/02/09 18:07:59  2010/02/09 18:22:21
REC Of Gaepo Bldg 11 2010/02/09 18:08:02  2010/02/09 18:22:24
REC OFF Gaepo Bldg 3 2010/02/09 18:08:03  2010/02/09 18:22:25
REC OFf Gaepo Bldg 6 2010/02/09 18:08:04  2010/02j09 18:22:26
Motion Event Gaepo Bldg 8 2010/02/09 18:08:04  2010/02j09 18:22:26
Motion Event Gaepo Bldg 11 2010/02j09 18:08:09  2010/02/09 18:22:32
REC OFf Gaepo Bldg 5 2010/02/09 18:08:10  2010/02j09 18:22:32

_] = —— o [resetn 7]
o] el @l o
o[ Ele B 8w 8]

| @ o [ |Gl e | O

adjust Color | € sequence | (&) Etc

Site Name. [ channel [ mic [udo [ Relay | HDD Status (Used { Total) |
(2 Busan Bldg 2F LHU@P DD D DDuddddd 2 4 é 228250 GB
® | &3 seoulidg 117 DECCCC e @ e eaE@ease @ < BEE@ &3 47850068
5 Goepo Bldg @EOLLELLLELLLLELE@E%E 0 < 3 104112068
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5.2 System
5.2.1 Log Manager
Log Manager is to manage an event log occurred in security devices and program function

usage.

5.2.1.1 Log View

1. Select ‘System’->’Log Manager’ menu. Log Search Manager setup window shows up.
£

nctian | Event | DvR Loa |

< 2010, February > ‘
Sun Mon Tue Wed Thu Fri Sat

1)z 3| 4| 5] 8
78" 9 0 n|ore 13
140 15 16 17| 18 19 @
2l 2 23] o 5| w7

User Graoup User Date Action

[“User
Group Group List (All) =
User User List (Al i

~Time:

Type Calendar =
Irkerval [0 E

Action
’7 ‘Actian List (All) -

2. For the program usage log, select ‘Action’ tab. Dates saved with logs will be shown in
the calendar. Select a desired date and log information will be shown. Searching by user,

time and function are available.
=

acton | event | o¥R Log |

< 2010, February > | [Fesskian
Sun Mon Tue Wed Thu Fri Sat
User Group. [ user | pate [ action S
o2 3| 4] 5 6| || Acministrator User Group  dministrator 2010/02/09.06:03:25  LOGACT_LOGIN_USER.
n Administrakor User Graup  Administrakor 2010/02/09 06:26:50  LOGACT_ADD_SITE
P8 8100 11012 13 ministrator User Group Administrator 2010/02§09 06:27:13  LOGACT_EDIT_SITE
W 8 18| 17 18| 19| 2| | Admnstrator serGrop  administrator 2010/02/09 0: LosAcT oo STTe
2 2 23| 24 B 2B 27
2 Adrainitrator User Graup 2010/02(0906:52: 11 LOGACT_CAMERA_START
Administrakor User Groop  Administrator 2010j02/09 06:52: 14 LOGACT_CAMERA_START
Adminitrator User Grop  Adminstrator 2010/02/03 06:52:17  LOGACT_CAMERA_START
adinitator User Grop Adriristrator 2010/02/03 0615328 LOGACT_ADD_SITE
Administrakor User Groop  Administrator 2010j02/09 06:53:44  LOGACT_CAMERA_START
lser—————————— || Adminstrator User Grop  Adminstrator 2010/02/03 0615348 LOGACT_CAMERA_START
adinitator User Grop Adriristrator 2010/02(09 0615352 LOGACT_CAMERA_START
Ern Group List (Al i Administrator User Group  Administrator 2010/02/0906:53:54  LOGACT_CAMERA_START
. [l ]| | Ao e e pcuitatr 2010/02/03 06:53:57  LOGACT_CAMERA_START
B User List (Al Administrator User Group Administrator 2010/02j09 06:54:00  LOGACT _CAMERA_START
Administrakor User Groop  Administrator 2010j02/09 06:54:03  LOGACT_CAMERA_START
e || Admnstrator UserGroop - Adminstrator 2010/02/03 06:54:05  LOGACT_CAMERA_START
adinitator User Grop Adriristrator 2010/02(09 06:54:11  LOGACT_CAMERA_START
Type Calendar | ||| Adwinistrator User Group — Adinistrator 2010j02/09 06:5415  LOGACT_CAMERA START ~ —
Adminitrator User Grop  Adminstrator 2010/02/03 06:55:17  LOGACT_CAMERA_START
Interval  [107in 21| || Acknistrator User Graup  Ackistrator 2010/02(09 0615520 LOGACT_CAMERA_START
Administrakor User Groop  Administrator 2010j02/09 06:55:26  LOGACT_CAMERA_START
Action Adminitrator User Grop  Adminstrator 2010j02/03 06 LOGACT_CAMERA_START
adinitator User Grop Adriristrator 2010/02(09 0615535 LOGACT_CAMERA_START
“ction List (A1) =] | || Administrator User Group ~ Adhiistrator 2010j02/09 06:55:39  LOGACT_CAMERA_START
Adminitrator User Grop  Adminstrator 2010/02/03 06:55:42  LOGACT_CAMERA_START
Adhinistrator User Group Achvinistrator 2010/02/09 06:55:44  LOGACT_SITE_START |

Group Mlame] Administrator User Group

User Hame] Adrinistrator

Local Time] 201002/09 06:52:02

User Action] LOGACT_CAMERA_START

Description] Site Name : Seoul Eldg 11F, Camers Hame : 121212, Channel ; 2049 (Sereen Index : 0)

3. For the event log in security devices, select ‘Event’ tab. Dates saved with logs will be
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shown in the calendar. Select a desired date and log information of events and alarms
will be shown. Searching by user, security device/PC time, site and event are available.
i

Action  Evert IDVR Log |
< 2010, February > [
Sun Mon Tue Wed Thu Fri  Sat -
Event [ site CH | SiteDate | Pc Date [ userra]
T2 3 41 5 B continuous Event Seoul Bldg 11F 1 2010/02/1000:10:51  2010/02/10 0010536 Admir—
T Continuous Event: Seoul Bldg 11F 2 2010/02/10 00:10:51  2010/02/10 00:10:37  Adrmir
TLOBT 90 1 120 13 continuous Event Seoul Bidg 11F 3 2010/02/10 00 2010/02/10 00:10:37  Admir
Continuous Event Seoul Bldg 11F 4 2010/02/10 00: 2010/02/10 00:10637  Admic
180 18 171819 20 continusus Event Seoul Bldg 11F 5 2010/02/10 00: 2010/02/10 00:1037  Admir
Continuous Event Seoul Bldg LIF 3 2010/02/10 00 2010/0210 00:10:37  Admir
Aol w B R T o Seoul Bldg LIF 8 2010/02/1000; 2010/0210 00:10:37  Admir
% Continuous Event: Seoul Bldg 11F 13 2010/02/1000; 2010/02/10 00:10:37  Admir
Motion Evenit Seoul Bldg 11F 5 2010/02/10 00; 2010/02/10 00:10:42  Admir
Motion Evenit Seoul Bldg 11F 15 2010/02/1000 2010/12/10 00:10042  Admic
Motion Evenit Seoul Bldg 11F 15 2010/0Z/1000:10:55  Z000/02(10 00:10:42  Admir
Motion Event Seoul Bldg 11F 13 2010/02{1000: 10:55  2010{02{10 00; 42 Admir
Clsr——————————— || Motion Evenit Seoul Bldg 11F 13 2010/02/1000:10:55  2000/02/10 00:10:44  Admir
Motion Evenit Seoul Bldg 11F 13 2010/021000:10:55  2000/02/10 00:10:46  Admir
Group Group List (All) d Motion Event Seoul Bldg L1F 13 2010/02/1000:10:55  2010/02/10 00:10:46  Admir
Motion Evenit Seoul Bldg 11F 15 2010/02/1000:10:S5  20L0/02/10 00:10:48  Admir
Wisar User List (Ally 1| || etion Even Seoul Eidg L1F 13 2010/02/1000:10:55  2010/02/10 00
Motion Event Seoul Bldg 11F 2010/02{1000: 10:55  2010{02{10 00;
Tine Motion Evenit Seoul Bldg 11F 2010/02/1000:10:55  2010/02/10 00
Oec Motion Everit Seoul Bldg 11F 13 2010/02/1000:10:55  Z000/02/10 D0:10:54  Admir
- [Gogr 3] Motion Evenit Seoul Bldg 11F 13 2010/02/1000:10:55  2000/02/10 00:A0:55  Admir
Motion Evenit Seoul Bldg 11F 15 2010/02/1000:10:55  Z000/0210 00 Adir
el [omn o] | || MotonEvent Seoul Bldg 11F 13 2010/02/1000:10:55  2000/02/10 00:A0:57  Admir
Motion Event Seoul Bldg LIF 13 2010/02/1000;10:55  2010[02(10 00:10:59  Admir
Motion Event Seoul Bldg L1F 13 2010/02/1000;10:55  2010/02/10 00:11:02  Admir
Sits Motion Everit Seoul Bldg 11F 13 2010/02/1000:10:55  Z000/02/10 00:11:02  Admir
Motion Everit Seoul Bldg 11F 13 2010/02/1000:10:55  Z010/02{10 00:11:06  Admir ™
Site List (All) hd il | _,l_l
[[Evert Name] Mation Evert
Event it Name] Seoul Bldg 1 1F
Channel] 13
Event List (All} il Site Date] 2010/02{10 00:10:55
Local Date] 2010/02/1000: 10:52
User hame] Administrator User Groupfadministrator

For the security device log, select ‘DVR Log’ tab. Dates saved with the log history will be
shown in the calendar. Select a desired date and the log information of the security

devices will be shown.

cton | gt D¥R 103 |

Seoul Bldg 11F Event [ ste
REC chedule Change  SeoulBldg 11F 2010{02(10 00:00:00
n E

CH [ Site bete [ Description
2010/02/1000:10:85 5 CH
/10 00:10:55 13 CH
2010/02/10 0061055 7 CH
2010/0210 00:10:55
2010/02/10 00:10:55
2010/02/10 00:10:55
2010/02/10 00:10:55
201002/ 10 00:10:56

{10

< 2010, February >
Sun Mon Tue Wed Thu Fii Sat
T AT

" " e" oMo n| 12| 13
14 15 15| 17 18 13 2

seouleldg LLF
SeoulBldg LLF

Motion Event SeolBldg LLF 8 o010/02(10 00:10:56
A miEi A BB A ion tvent SeoulBldg LLF 13 20I0MZ/10 00:24:50
o8 Motion Event SeoulBldg LLF 6 2Z010/02(1000:24:50
Motion Event SeoulBldg LLF 12 2010/02/10 00:24:50
Motion Event SeoulBldg LLF 7 2010i02/10 002451
Motion Event SeoulBldg LLF 3 2010/02(10 00:24:51
Motion Event SeoulBldg LLF 1 2010/02/10 00:24:51
Motion Event SeoulBldg LLF 5 2010i02/10 002452
Motion Event SeoulBldg LLF 2 Z010i02(10 00:24:52
Motion Event SeoulBldg LLF 8 2010/02(1000:24:52
Motion Event SeoulBldg LLF 4 2010i02/10 002452
Motion Event SeoulBldg LLF 7 Z010j02(10 004111
Motion Event SeoulBldg LLF 2 omojozfinonis06
Motion Event SeoulBldg LLF 5 2010i02(10 011506
Motion Event SeoulBldg LLF 6 Z010/02(1001:1506
Motion Event SeoulBldg LLF 13 2010/02/10 0L:15:06
Motion Event SeoulBldg LLF 3 2010i02(10 011506
Motion Event SeoulBldg LLF 4 Z010/02(1001:15:06
Motion Event SeoulBldg LLF 7 om0jozfin L1506

‘Evert Name] Motion Event.

Site Name] Seoul Bidg 117
Channel hum] 3

St Time] 2010/02/10 00: 10156
Description]

Note m The time used in ‘Action’ log is based on PC time. The time used in ‘Event’

and ‘DVR Log’ is based on the time of the security device.
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5.2.2 App Setup

P App Setup

¥ App Setup

e

[pvinnad =]
r

¥ App Setup

P App Setup

P App Setup

¥ App Setup

O Record off

I Record Sensor
I signal act

[ sigral Loss

[ video Discornect
[ video Covert
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¥ App Setup x|
¥ App Setup x|
Storage | 050 | Boarderline | AlarmOut | Instantlive |
Storage | 080 | Bordertne | MarmoOt | Instanklve | Display Playback Language | Backup
Disglay Flaback | Lanquage | Bacup
Playback ertical Mode
Playback Vertical Mode
I vertical Hode
I™ Vertical Mode [ App Sewp |
Gpdlltinmpdey ————————————— storage | osp | Goarderiine | Atarmout | mstantive |
Playback ast image display Dislay | Playback T Backup
[ Last image display Mode
[¥ Last image display Mode:
Backup Data
© fpp Setting
= address Book, Uss &.Group, Event List
=
Cancel cancel cancal

1. Select ‘System’->’App Setup’ menu. App Setup window shows up.

2. In ‘Storage’ tab, users can designate saving folders for the capture image file, record file and

DVR setup file.

3. In ‘OSD’ tab, users can configure the name, height, thickness and color of the font to be

displayed above the real-time monitoring screen. Also it sets up Enable/Disable of the time,

resolution, title and other information to be displayed above the screen.

4. In ‘Border Line’ tab, users can configure the thickness and color of the border line that

indicates the border line between channels in real-time monitoring.

5. In ‘Alarm Out’ tab, users can configure the alarm out, sound effect and duration in case

events including ‘Power Off’ and ‘DVR Operation Fail’ occur from security devices.

6. In ‘Instant Live’ tab, users can enable/disable the event live popup and event popup image

and setup the number of instant live viewers.

Event

Description

Record Off

An event that occurs when recording is stopped.

Record Continuous

An event that occurs during continuous recording

Record Motion

An event that occurs from motion detection

Record Sound

An event that occurs when it detects an audio sound from

the mike

Record Sensor

An event that occurs from a sensor input

Signal Act

An event that occurs from a image input

Signal Loss

An event that occurs from a signal loss

Video Disconnect

An event that occurs when a camera is not connected
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Video Covert An event that occurs when a camera is set to the covert

function

7. In ‘Display’ tab, users can change the pixel size and setup the video filter. Also a size, font

and color of letters; ‘Connecting’, ‘Signal Loss’ and ‘Video Disconnect’ can be decided.

8. In ‘Playback’ tab, users can setup the vertical playback mode and last image display mode.

9. In ‘Language’ tab, users can select languages including English, Korean, Japanese, Polish,

Hebrew, Portuguese, Spanish, Cantonese, Pekingese and Russian.

5.3 Setup
5.3.1 Edit Password

1. Select ‘Setup’->’'Edit Password’ menu. Edit Password setup window shows up.

P Edit Password

x|

User Mame :

Password | Innon

Confirm : I.......

[ o 1|

Cancel

2. Users can change the password of current logged-in ID.

5.3.2 User Information

1. Select ‘Setup’->'User Information’ menu. User Information setup window shows up.

P User Information (Permission}

x|

Group Mame : IAdministrator User Group

User Mame © aministrator

| Permissions

Remote Live Monitoring
Remote File Search
Remote Fils Playback
Remate File Download

File Playback

Remote DYR Setup

PTZ Camera Control

Two way Audio Cantrol
Relay Control

DVR Praduct Information
Remote Live Pickure Setting
Wetwork User Account

Loq file Yiewsr

Application Setting

DWR Address Book

Picture Snapshot

Picture Print

User & User Group Manager
Picture Color Adjust
Picture Recording

F Cancel
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2. The name, group and group authority of the current logged-in user are displayed.

6. Viewer
6.1 Viewer Overview
The viewer is a multi-channel real-time program displaying a customized screen of multi-channel

real-time monitoring images.

The viewer is a main function of the program and incorporates all program menus. It consists of
various panels including Site Connection List, Screen Layout List, Event List, Basic Control

Function and Status List Popup Image.

Users can check real-time events, status and connection information of the security device
connected in Site Connection List, Event List and Status List. In Screen Layout List, users can
customize channels and modes for real-time monitoring. In Popup Image, an image of the
important event moment is captured and saved in an image format. In Basic Control Function, it

provides PTZ, Relay, Two way Audio, Color Adjustment, Sequence and other functions.

6.2 Image View

In Viewer, there are three ways to have the real-time monitoring image. The first way is to drag a
security device icon into the screen and all channels of the security device are displayed. The
second way is to drag cameras from the security device list to desired locations of the screen and
the selected camera will be displayed at the selected location. The third way is to collect cameras

of the security devices in Screen Layout Function.

Em m The channel mode automatically changes according to the number of added

Note )
cameras when the user drag/drop icons.

m Images being displayed in the viewer move to other locations by dragging
images.
m images exchange each other if a image is dragged onto an occupied

location.
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6.2.1 Image View by connecting security devices
1. In Site Connection List, select a desired security device icon to be monitored.

2. Drag the icon into the viewer screen, and then all channel of the security device are

displayed.

Em m To disconnect the security device, right-click on a desired icon, and then

Note . :
select ‘Disconnect’ in the popup menu.

m The channel mode automatically changes according to the number of
channels.

m The max. number of channels to be displayed in the viewer are 64.

6.2.2 Image View by connecting cameras
1. In Site Connection List, double-click on a desired security device icon to be real-time

monitored. Select camera icons from the camera list of the security device.

2. Setup a layout by selecting a channel mode in Channel Mode.

ODEEEEEEEHHEE D@

3. Drag camera icons onto the viewer screen, and then real-time monitoring images are

displayed.

':EI m To disconnect the camera, drag a desire monitoring image out of the viewer
Note screen.
m Users can setup the layout by 1, 4, 6, 8, 9, 10, 13, 16, 25, 36, 49, 64

channel mode.

6.2.3 Image View through the second monitor

1. In View menu, select the second screen or click on @ button in Tool Bar. The second
monitor shows up.

2. Move the second screen to the second monitor.

3. Setup the layout by selecting a channel mode in Channel Mode.

4. Repeat 6.2.1 or 6.2.2 to bring images on the second screen.
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EEI Note = To disconnect the camera, drag a desire monitoring image out of the second

viewer screen.

A Caution = To use more than two monitors, the video card in PC must support the dual-

Caution monitor or more.

6.3 Event List
6.3.1 Event Information View

1. In View menu, select an event list or click on =] button in Tool Bar. The event list window
pops up.

2. Events occurred in connected security devices automatically are indicated in the event

list.(No setup needed)

EEI Note = The event list window is a docking window so that users can place the icon

at a desired location and have a separate window.

6.4 Status List
6.4.1 Security Device Status Information View

1. In View menu, select a status list or click on @ button in Tool Bar. The status list shows up.

2. The status list shows status of the connected camera including PTZ Connection, Video
Disconnect, Signal Loss and HDD status, and also indicates Two way Audio enable/disable,

Relay enable/disable and HDD occupied/total capacity.

':EI Note m The status list window is a docking window so that users can place the icon

at a desired location and have a separate window .

6.5 Popup Image
Popup Image is a window showing a thumbnail real-time image transmitted from the security

device when an event occurs. Setup in ‘App Setup’.
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Eﬂ Not m To bring thumbnail images in case of the event occurrence, tick on ‘Event
ote
Popup Image’ in ‘Instant Live’ tab at ‘App Setup’. (For more information,

refer to '5.2.3’ App Setup.)

6.5.1 Thumbnail Image View in Popup Image Window

1. In View menu, select a popup image or click on @ button in Tool Bar. The popup image
window shows up.

2. The thumbnail image automatically shows if an event occurs from connected security

devices. (Setup needed in App Setup)

Popup Image i x

ot

2010{02/10 15:09:00

\

2010{02{10 15:09:00

ol
G

2010/02/10 15:09:00 ;j

Event: Motion Event
Site: Gaepo Bldg
Channel: 14

Date: 2010/02/10
Time: 15:09:00

6.6 Basic Control
Basic Control consists of PTZ control, Relay control, Two way Audio, Color adjustment, Screen

sequence and other functions.

6.6.1 PTZ Control
PTZ Control is to control the PTZ camera with functions including Move, Zoom In/Out, Focus

Adjustment, Preset, Speed Adjustment and Tour 1/2.
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PTZ Movement Control
1. Select a PTZ camera to be moved.

2. Move the PTZ camera by pressing four direction keys.

™

EINE

PTZ Focus Control
1. Select a PTZ camera to be focus-controlled.

b = .
2. Press == =2 puytton to adjust the focus.

PTZ Zoom Control

1. Select a PTZ camera to be zoom-controlled.

2. Press Q Q button to zoom in/out.

PTZ Preset Control

1. Select a PTZ camera to be preset-controlled.

+
2. Select a preset number and press button. The camera moves to a preset position.

3. To designate a certain position as a preset position, move the camera to a desired position

and select a preset number, and then press [‘%J button. The position is saved as the preset

position.

PTZ Speed Control

1. Select a PTZ camera to be speed-controlled.

2. Adjust the speed by moving the sliding bar iﬂ The speed of the PTZ camera gets faster
or slower.

PTZ Tour Control

1. Select a PTZ camera to be tour-controlled.

2. Press i1 button and the PTZ camera moves according to the tour no.l. Press &

button and the PTZ camera moves according to the tour no.2.
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6.6.2 Relay Out Control
Relay Out Control is to setup the relay On/Off that is connected to the security device. The

number of Relay Out varies depending on security devices.

1. Select a site to be relay out-controlled from the list.

2. Press ,3_1‘ button and request a relay out-control to the security device.

3. Status of the relay out is shown by @(Oﬁ) @(On) buttons.

4. The button is designed to be toggled. (On->Off, Off->0n)

':EI Note = The time out of the relay out is 5 seconds. After 5 seconds, the user has to

reqguest it again.

6.6.3 Two way Audio Control
Two way Audio Control is to send an audio sound from the program to a speaker of the security

device.

1. Select a site to be two way audio-controlled from the list.

2. Press D button and speak to a mike connected to PC.

3. Avoice comes out of the speaker connected to the security device.

':EI Note = The time out of the two way audio is 120 seconds. After 120 seconds, the

user has to request it again.

6.6.4 Color Adjustment
Color Adjustment is to adjust color of the real-time monitoring image in the viewer screen.

1. Select a screen to be color-adjusted.

2. Adjust the value of Brightness, Gamma, Contrast, Saturation and Tint.

3. All channels can be adjusted with the same value by ticking on ‘All Channel’.
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EEI Note = The color adjustment value returns to the default value when program

terminates.

6.6.5 Screen Sequence Function
Screen Sequence Function is to rotate the layout of the real-time monitoring image in the viewer

screen according to a desired time interval.
1. Select a channel mode. (1, 4, 9, 16 channel mode)

2. Select a rotation time interval. (2seconds ~ 60seconds)

3. Press @ button and it starts the rotation according to the set value.

6.6.6 Other Functions
Other functions include real-time monitoring screen capture, printing of the captured image, real-

time image recording and full screen.

1. Press @button and it saves the real-time monitoring screen as a file and brings the image
editor ‘Picture Viewer’. This editor allows users to edit images by using the color adjustment

and filter. (In 5.2.3 App Setup -> Storage tab, a saving folder is shown.)

- Picture! Viewsr - 10).x)

SavelNamei [
ERIN] SN me

BAT S 2 ISIRES R IO TV i

(5
2. Press button and it starts to record the real-time monitoring screen and audio together.
The saved file can be played through ‘File Player’.

3. Press EI button and it changes to the full screen. Press ‘ESC’ key for return.

4. Press @ button. A captured image file list is shown and selecting one of them leads to the
image in the reporting format document. Press the ‘Print’ button.
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T
| |

File Name : 201002111110 bmp
File Date : 2010/02/11
File Time : 11:10

Memo

Print Close.

7. Network Player
7.1 Network Player Overview
Network Player allows users to search and playback recorded images and audios of the security

device in multi-channel from distant PC.

Users can use a preview search to find recorded images and audios. Searching and thumbnail
images by a second term are available. Users can download images and audios of the desired

time period into PC.
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7.1.1 Playback of the Recorded Image

]
1. Select icon in Tool Bar.

2. Setup searching conditions(Camera/Security device, Date/Time) in the searching panel of

the player at left.

. , . . )
3. Designate a desired time to be played in ‘Go to’ and press button.

File(E) Viewty) Mode(M) Help(H)

.|
B
N I

Date / Tme

FEEEEEEEIR:

< 2010, February >
Sun Mon Tue Wed Thu Fri Sat

':EI Note = The player can display recorded images of max. 16 cameras at the same

time. (One security device)

7.2 Search

Users can search recorded images and audios in the security device by two means; the time

search and preview search.

The time search is to designate a certain date/time and bring images appertaining to the

designated date/time.

The preview search is to select a certain date and hour. A time line between Ominute Osecond ~

59minutes 59seconds shows up. Users can view thumbnail images by 1 second term.
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Eﬂl Note B The way of the search in the player may be different from
the way in the security device.

7.2.1 Time Search

1
1. Select icon in Tool Bar.

2. Select a security device to be played from ‘Connect List’ at the top-left.

3. Select a date and time to be searched.

4. Press button. Recorded images of the desired date/time are played on the top-right of

the screen.

5. To re-setup the search condition, press @ default button.

Eﬂl Note = Users can select max. 16 cameras.

7.2.2 Preview Search

]
1. Select icon in Tool Bar.

2. Select a security device to be played from ‘Connect List’ at the top-left.

3. Select a date and time to be searched and press @3: button.

4. Setup a desired time to be searched at ‘Go to’, bottom-left and press - button. The time

line of the preview search is shown.
5. As the time bar moves by one second term in the preview search, the preview thumbnail

changes accordingly.
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Canera
) 2 ) e T e
I |
Date [ Tme
< 2010, Febr >
Sun Mon Tos Wed Thu Fl Sat
1| 2] 3] 4] 5] &
1% 0" 9"l 2 1
o5 B 17 1|8 19 A
A 2 B U B % 0

Enmnk 3, Timeline Search

6. ‘To re-setup preview search conditions, press @ default button.

Eﬂl Note = Users can select max. 16 cameras.

7.3 Playback

7.3.1 Playback Overview
After searching images and audios by two means, searched images and audios are played
automatically if the user presses a playback button. The channel mode is automatically

determined according to the number of cameras.

In the playback screen, the channel title, date/time and other information are displayed. Also,

rectangular boxes with event colors are displayed at the bottom-left.

Multi-channels are played in the division mode. Double-clicking on a certain channel leads to the

full screen. For return, double-click on the full screen.
In the time line, image information(recording event status) being played is indicated in color.

Users can move the bar and play at a desired location and also the snapshot and printing are

available.
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7.3.2 Time Line

Time Line indicates images and audios of the designated search condition and events by each

channel in graphic lines.

-1 DU WM

Wﬁ@

=

The green line indicates that a recorded data exists. The red line means that an event recording

data exists. The green space is that there is no data. Using a scroll at right, users can check the

recorded event data from channel 1 to 16.

7.3.3 Playback Control

It indicates images and audios of the designated search condition and events by each channel

in graphic lines.

Button

Function

Remark

Fast Reverse

Reverse Play

Reverse one frame

Pause

Play one frame

Play forward

Fast Forward

Play Speed Adjustment

(L4 ] button for speed up, [L® ] button for slow down.

Indication by events in the time line

A Caution _ _ _ _
m Some of the security devices may not be supported with all functions.

Caution
7.3.4 Control
In Player, users can use a channel mode change, full screen, zoom function, capture and print
function.
Button Function Remark

CEEE

Playback in 1, 4, 9, 16 channel mode

=

Full Screen
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Image Enlargement (100%, 150%, 200%, 300%, 500%,
< 700%, 1000%, 1600%)
@ Screen Capture

@ Screen Print

7.4 Download
In Download, users can download and save recorded images and audios from the security

device to PC.

7.4.1 Download of the Recorded Data

]
1. Select icon in Tool Bar.

2. Select a security device to be played from ‘Connect List’ at the top-left.

3. Press E' button and the download window pops up.
4. In the download window, setup a start date/time and end date/time, and then tick on desired

channels and designate a saving route.

5. Press ‘Start’ button to initiate downloading.

iFix
= EE Channel
[or00z-11 = Jioaran = Flci1  WicHz  MicHs  VicH4
WcHs W aHe W cH7 W cHs
M To VcHe WeHio W cH1t VocHiz
|2n10-02-11 — IIMS:D1 = McHiz McHid W aHis [ ocHis  #oal

i~ File download Information

Download Folder Path | W TempyideoWt100211104101 _100211105101_Seoul Bldg 11F |

HOD Free Space @ 1.02GE

Dowrload Size : §4.4MB

r— File Download Progress

L[

2.85ME | 84.4MB

Cancel

':EI m The download data is saved as a folder and the folder name is “start

Note
date/time_end date/time”.
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8. File Player
8.1 File Player Overview
File Player is to search and play a downloaded image/audio file in the PC in multi-channel screen.

Smart Search enables users to search in the thumbnail image list of the motion detection.

8.1.1 Playback of the Recorded Data

1. Select @ icon in Tool Bar.

2. In Tool Bar, select a data folder by pressing % or % button. (In ‘File’ menu, users can

select ‘Folder Open’ or ‘File Open’.)

3. It starts playing recorded data files.

-lnixg
File ewl¥) Play(®) Tool(D HelpcH)

&lo B d|m

s0E@en

o 5 L 15 @ b3 S £
: i ; i i

8.1.2 Time Line
Time Line indicates images and audios of the designated search condition and events by each

channel in graphic lines.

=

The green line indicates that a recorded data exists. The red line means that an event recording
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data exists. The green space is that there is no data. Using a scroll at right, users can check the

data of the recorded events from channel 1 to 16.

8.1.3 Playback Control
It indicates images and audios of the designated search condition and events by each channel

in graphic lines.

Button Function Remark

Fast Reverse

Reverse Play

Reverse one frame

Pause

Play forward

Fast Forward

Play Speed Adjustment

[<4]
(<]
[«1]
[u]
E] Play one frame
[>]
[>»]
=

| [L4 ] button for speed up, [L® ] button for slow down.

Indication by events in the time line

A Caution , , , ,
m Some of the security devices may not be supported with all functions.

Caution

8.1.4 Control
In Player, users can use a channel mode change, full screen, zoom function, capture and print
function.
Button Function Remark
@ Playback in 1, 4, 9, 16 channel mode
@ Full Screen

Image Enlargement (100%, 150%, 200%, 300%, 500%,
< 700%, 1000%, 1600%)

[@ Screen Capture

@ Screen Print

8.2 Smart Search
Smart Search is to search a motion in the specific area of the recorded image data. searched

images are saved as thumbnail images in time sequence.
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8.2.1 Smart Search

3 . .
1. Select “& putton in Tool Bar. (Select ‘Smart Search® in ‘Tool’ menu)

2. Setup a desired area to be motion-searched.

3. Select a desired channel to be smart-searched, start date/time and end date/time.
4. In Time Interval, select ‘All Images’ or ‘Time Interval(sec).

5. Press ‘Search’ button and it starts smart-searching

i1
— Channel
f1cH =l
— Start Time
3 |2010-02-11 =l IQE 10:00:00 =
- - ~ End Time —————————
|2010-02-11 | ISE 10:01:05 =
= = 3 : =) & ~ Time Interval (sec)
[ | - - > & all Images
I I ! 4 f\ . 7’ " Time Interval (sec)
[ 10::11
Search |
=
=
Close |

6. Select searched thumbnail images and press ‘Playback’. It starts the playback from the

selected time period.
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9. Security Device Setup Administrator

9.1 Security Device Setup Administrator Overview

Security Device Setup Administrator is to setup security devices from a remote PC directly. The
administrator can save a setup value and apply it to other security devices to make the same

configuration. The administrator can open and edit a setup value file.

9.2 Start of the Security Device Setup

d
1. Select é’ button in Tool Bar.

2. Users can change a setup value of the security device by using Security Device Setup
Administrator.

3. After changing setup values, press ‘Send’ button’ and the changed setup value applies to the
security device.

P DVR Setup Manager (192 168_100.53) I e 5|

File Help

(@) PTZ Setup | 2 NTP Setup | @8 Metwork Setup | % MNetwork Port | [l DDNS Setup | Bl Bandwidth | 75 Schedule |
&2 Fecord Setup | . Ewvent Setup | & Alarm Setup | @® Systern Setup | T} Storage Setup | 4¢ Adwvance d Setup

= Data 1 « Data 2 ¢ Data 3 ¢ Data 4

Carmera Infornation

Camera Mame | AN

Record Setup

Resolution ZIF ~

Cuality [“ery High =]
Record Mode [aote =]
Record Event [Recard Made Off |

Frame Rate Mormal : 30 ~
Ewvent : ED) ~
Audio Channel on -

send | [ Cancel 1]

9.3 Open/Save Setup Value
1. Goto ‘Open’in ‘File’ menu and select a file.
2. After changing setup values, select ‘Save’ or ‘Save as’ in ‘File’ menu and save the setup value.

3. Press ‘Send’ button’ and changed setup values apply to the security device.

9.4 Setup Data Reset and Factory Default Reset

1. Press ‘Setup Data Reset’ in ‘File’ menu, all changed values reset to the initial setup value.

2. Press ‘DVR All Reset’ in ‘File’ menu, all values reset to the factory default value.

3. After changing setup values, press ‘Send’ button’ and changed setup values apply to the

security device.
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Q Cauti m Please be aware that ‘DVR All Reset’ function resets a security device to
aution
Caution the factory default value including the network address so that users can'’t

access to the security device.

39



